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Getting Started

Welcome to Survey Crafter Professional, the complete survey and 
analysis tool from Survey Crafter.

Survey Crafter Professional is a powerful yet simple-to-use tool for 
survey research that enables you to quickly collect and easily understand 
critical information about your customers, prospects, employees, and 
other audiences. By helping you get closer to your customers and 
employees, Survey Crafter Professional lets you empower your 
decision-making with real data and enables you to win in a competitive 
environment.
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Greetings and welcome to the newest version of Survey Crafter 
Professional.

In keeping with a commitment to helping you easily administer surveys 
and systematically analyze the results, Survey Crafter continually works 
on and improves its product, Survey Crafter Professional. Survey 
Crafter Professional 5.1.2 contains all of the great features from 
previous versions plus many new ones.

The following are three of the new features in Survey Crafter 
Professional 5.1.2 and 5.1.

• Find/Replace in the Data window. You can now use the Data 
window's new Find/Replace command to search the data in the 
window for any combination of characters, numbers, words or 
phrases. You can also use the command to make changes to the data.

• Slider controls on web surveys. You can now configure your 
quantity, ranking and constant sum questions to include slider 
controls for your online respondents to use to answer your questions. 
The slider controls and quantity boxes are linked so your respondents 
can choose either or both methods to answer your questions. You can 
have the controls appear above, below, to the left, to the right, or in 
place of the quantity boxes.

• Improved quota enforcement on your web surveys. The new 
CURRENT_VALUE, RECORD_VALUE and WEB_COLUMN_VALUE 
expression language functions increase the number of occasions 
where you can enforce quotas on your web surveys. For example, you 
can use the new CURRENT_VALUE function in a rule to screen out a 
respondent when the respondent's answers to one or more questions 
match the answers provided by a specified number of other 
respondents, without your having to include what those answers are. 
This allows you to more easily enforce quotas on an open-end 
question that asks for the respondent's zip code, for example.

We’re confident that this version of Survey Crafter Professional will 
help your organization develop a better understanding of your 
customers, employees, and prospects. Good luck and keep the great 
comments coming!

The Survey Crafter Professional Team
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What’s in the Package?

The Survey Crafter Professional package contains:

• A compact disc sleeve

• A compact disc

The Compact Disc Sleeve

The Survey Crafter Professional compact disc sleeve contains installation 
instructions and a serial number sticker on the back.

The Compact Disc

The compact disc contains the Survey Crafter Professional application 
and supporting files, including the Survey Crafter Professional Quick 
Preview and the Getting Started, Understanding Survey Research:  A 
Primer for Success, Survey Crafter Professional User’s Guide, and 
Surveying on the Web online books.

Survey Crafter Professional Quick Preview introduces you to Survey 
Crafter Professional’s primary features by walking through an example 
study about a fast food restaurant.

Understanding Survey Research:  A Primer for Success gives an overview 
of the survey research process and provides practical guidelines for 
planning and conducting a survey. We recommend that you read the 
Primer before using the software.

Survey Crafter Professional User’s Guide explains how to use the 
software to write surveys and how to enter, edit, and analyze survey 
responses.

Surveying on the Web explains how to use the software to administer your 
surveys on the World Wide Web.
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What’s New in Survey Crafter Professional

This section contains brief descriptions of the most significant 
improvements and new features in releases 5.1 and 5.1.2.

Release 5.1.2

Release 5.1.2 contains improvements made to the Data window and 
Interviewer.

Improved/New Data Features
• Find/Replace in the Data window. You can now use the Data 

window's new Find/Replace command to search the data in the window 
for any combination of characters, numbers, words or phrases. You can 
also use the command to make changes to the data.

• Spell-checking in the Data window. You can now check and correct 
the spelling of the responses to your surveys' open-end questions as 
well as the values contained in the study's other imported literal 
variables in the Data window.

• Spell-checking in the Interviewer. You can now also check and 
correct the spelling of the responses to your surveys’ open-end 
questions in the Interviewer.

Release 5.1

Release 5.1 contains several exciting improvements to the Survey 
Designer and Analysis windows.

Improved/New Survey Features
• Slider controls on web surveys. You can now configure your quantity, 

ranking and constant sum questions to include slider controls for your 
online respondents to use to answer your questions. The slider controls 
and quantity boxes are linked so your respondents can choose either or 



      Getting Started 7 
What’s New in Survey Crafter Professional
both methods to answer your questions. You can have the controls 
appear above, below, to the left, to the right, or in place of the quantity 
boxes.

• Running totals for constant sum questions. You can now configure 
your constant sum questions to display running totals, making it easier 
for your online respondents to enter answers that sum to the desired 
total.

• Improved quota enforcement on your web surveys. The new 
CURRENT_VALUE, RECORD_VALUE and 
WEB_COLUMN_VALUE expression language functions increase the 
number of occasions where you can enforce quotas on your web 
surveys. For example, you can use the new CURRENT_VALUE 
function in a rule to screen out a respondent when the respondent's 
answers to one or more questions match the answers provided by a 
specified number of other respondents, without your having to include 
what those answers are. This allows you to more easily enforce quotas 
on an open-end question that asks for the respondent's zip code, for 
example.

• Cookies and your web surveys. There is a new custom rule you can 
add to your surveys that has Survey Crafter Professional get and set a 
cookie from your respondent's browser as the respondent takes your 
survey. You can add any number of these rules to your surveys, having 
Survey Crafter Professional get and set as many cookies as you want. 
One use of a cookie is to help uniquely identify your web survey’s 
respondents, giving you another way to prevent a respondent from 
completing your web survey more than once.

• Add ranking calculations to your web surveys. You can now use the 
improved RANK and the new RANK_PERCENT expression language 
functions with CURRENT_VALUE in computed survey fields to 
display rankings and percentiles of the respondents' answers as they 
take your web survey.

• The improved instruction-only block. An instruction-only block can 
now be a table of up to 255 rows and columns.
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• Improved warning messages and submit-anyway feature. The 
default warning messages for ranking questions have been improved 
and you can now have the button that allows respondents to submit their 
answers despite warnings appear at the bottom of the web survey page 
instead of at the top.

Improved/New Analysis Features
• New sort feature in analysis tables. You can now select a range of 

cells in any analysis table and have its cells vertically or horizontally 
sorted, using up to 3 columns or rows to determine the sort order.

• New undo/redo feature in analysis tables. You can now undo and 
redo any operation in an analysis table, including re-running the table's 
analysis wizard.

• New statistical significance testing option in the Descriptive 
Statistics analysis table wizard. When you have the Descriptive 
Statistics analysis wizard include a cross tabulation variable, you can 
now have the wizard also include a test for statistical significance of the 
differences between the means of each of the respondent groups the 
variable produces.

• New count and percentage calculations in the Counts and 
Frequencies and All-That-Apply Question analysis table wizards. 
You can now have these wizards show the number of respondents for 
whom a selected variable holds any valid value as well as the number of 
respondents who answered the variable's associated question. In 
addition, you can have these wizards show the percentage of 
respondents who picked a prompt or entered a specific value against the 
number of respondents who answered the variable's associated 
question.
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Hardware and Software Requirements

Survey Crafter Professional has these minimum system requirements:

• A Personal Computer running one of the following:

• Microsoft Windows® 11, 10, 8.1, 8, 7, Vista, XP, 2000, NT® 4.0 
SP 3 or higher, Me, 98, or 95 with DCOM95 1.3 or higher

• 80 MB of available hard disk space

• VGA or higher resolution monitor
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Installing Survey Crafter Professional

Follow the steps below to install Survey Crafter Professional on your 
computer. Although none of your existing Survey Crafter Professional 
files will be lost or changed, it is good practice to back up your files 
before upgrading any application in case a problem occurs.

• To install Survey Crafter Professional

1 Insert the Survey Crafter Professional compact disc into your 
computer’s compact disc drive (the D:\ drive).

2 Wait a minute. If the installation program starts automatically, skip to 
step 6.

3 Click on the Windows Start button.

4 In the search box, type the drive letter that corresponds to the 
CDROM drive (ex. D), a colon (:) and a backslash (\), followed by 
SETUP.EXE. For example, D:\SETUP.EXE.

5 Press the Enter key.

6 Follow the directions on the screen to complete the installation.

The installation program asks you for your copy’s serial number. You 
can find this serial number on the back of the Survey Crafter 
Professional CD sleeve. Use this serial number even if you are 
installing this version as an upgrade.
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Registering Your Copy

If you purchased your copy of Survey Crafter Professional from Survey 
Crafter, the software has already been registered.

If you did not purchase your copy from Survey Crafter, please register the 
software by calling Survey Crafter at (877) 650-8527 or (978) 635-1717. 
Alternatively, you can email your registration information to 
support@surveycrafter.com. Registering your copy of Survey Crafter 
Professional makes you a licensed user.

As a licensed Survey Crafter Professional user, you’ll receive discounts 
on upgrades. You’ll also receive free technical support.

Please record your copy’s serial number and keep it in a safe place. You 
will need your serial number if you request technical support. The serial 
number appears on the back of the Survey Crafter Professional CD 
sleeve. If Survey Crafter Professional has already been installed, you can 
also find the serial number by clicking on Survey Crafter Professional’s 
Help menu and then on About Survey Crafter Professional.
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Starting Survey Crafter Professional

When you start Survey Crafter Professional, the Welcome screen appears, 
giving you the option of opening your last study (if applicable), creating a 
new study, or taking an online tour of Survey Crafter Professional.

• To start Survey Crafter Professional

1 Click on the Start button and then on All programs. Scroll the list of 
programs until you see a folder called Survey Crafter Professional 
5.1, click on it and then on Survey Crafter Professional 5.1. 
Alternatively, double-click on the Survey Professional icon on your 
desktop.

The Welcome screen appears.

2 Click on an option on the Welcome screen.

Figure 1: Survey Crafter Professional’s Welcome screen.

Survey Crafter 
Professional icon

If you are new to Survey 
Crafter Professional, 
click on Take a guided 
tour for a tour of Survey 
Crafter Professional’s 
features.
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Getting Help

In addition to the Survey Crafter Professional User’s Guide and 
Surveying on the Web, help for using Survey Crafter Professional ranges 
from online help and tips to technical support.

Online Help

Survey Crafter Professional’s Online Help System provides quick access 
to procedures and reference information on dialog boxes and menu 
commands. You can access general or specific help from Survey Crafter 
Professional’s Help menu and context-sensitive help from any dialog box, 
menu command, or window.

Figure 2: The Contents topic of the Survey Crafter Professional Online Help System.

• To access general or specific help from Survey Crafter 
Professional’s Help menu

From the Help menu, choose one of the following:

• The Contents command to see the Contents topic of the Survey Crafter 
Professional Online Help System 
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• The Search for Help On command to search for a specific help topic

• To access context-sensitive help from a dialog box

When the dialog box’s title bar is highlighted, click on the dialog box’s 
Help button or press the [F1] key.

A help topic describing the dialog box’s function and options appears.

• To access context-sensitive help from a menu command

When the menu command is highlighted, press the [F1] key.

A help topic appears that describes the command’s action or the dialog 
box it displays.

• To access context-sensitive help from any Survey Crafter 
Professional window

When the window’s title bar is highlighted, press the [F1] key. 

The help topic for the window appears. 
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Tips

You can read online tips about performing survey research and using 
Survey Crafter Professional. Survey Crafter Professional displays a new 
tip in the Tip of the Day dialog box each time you start Survey Crafter 
Professional. You can also read tips any time during a Survey Crafter 
Professional session by choosing the Tip of the Day command from the 
Help menu.

Figure 3: The Tip of the Day dialog box.

Click on this button to 
browse a full list of 
Survey Crafter 
Professional tips.
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Technical Support

If you are having trouble using Survey Crafter Professional, please read 
the pertinent sections of the online documentation or online help. If you 
are still having trouble after reading the documentation, contact Survey 
Crafter for technical support weekdays from 8:30 AM to 5:30 PM, 
Eastern Standard Time:

• (877) 650-8527 or (978) 635–1717 (phone) 

• (978) 635–3734 (fax) 

• support@surveycrafter.com (email)

Please have your copy’s serial number available when you call and 
include this number in any fax or email you send to Survey Crafter.

While you’re at the website, see Survey Crafter Professional’s FAQ 
for a list of frequently asked questions about Survey Crafter Professional. 
The answers to these common questions can help you use Survey Crafter 
Professional more effectively and efficiently.
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Overview of Survey Crafter Professional

A Survey Crafter Professional project file is called a study. A study 
contains the components shown in Figure 4 below. Each of the 
components in the figure below is explained later in this section.

Figure 4: Components of a Survey Crafter Professional study.



18 Getting Started
Overview of Survey Crafter Professional  
The Study Window

Survey Crafter Professional organizes these components in the Study 
window, your home base in the software. Figure 5 shows the Study 
window.

Figure 5: The Study window.

The Study 
window’s tabs 
correspond to 
the four 
components of a 
study.
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Surveys

The Survey Designer window is where you enter and format your survey. 
It has many features that you can use to arrange and format the titles, 
instructions, pictures and questions that make up your survey.

Figure 6: Survey Crafter Professional’s Survey Designer window.

Survey title 
and 
introduction

Survey 
questions

Survey 
design and 
format 
toolbars

Question 
Block 
Layouts 
toolbar

Survey 
Question 
toolbar

Survey 
Explorer 
toolbar
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Typing Directly in the Survey Designer window
You can type titles, section headings, instructions and other text directly 
in the Survey Designer window.

Figure 7: Typing and formatting directly in the Survey Designer window.

You can format the text by changing its font, font size, style, spacing, 
foreground and background colors. You can format a paragraph of the text 
by changing its alignment, indentation, spacing, borders and shading. You 
can use tables, tab stops, bullets and numbering to organize and align the 
text. You can also have Survey Crafter Professional automatically check 
your spelling as you type.

You can also insert pictures, hyperlinks, hyperlink targets, bookmarks, 
frames, drawing objects, page breaks, page numbers, page counts, and 
dates in your survey.

Text that was 
typed and 
formatted 
directly in the 
Survey 
Designer 
window.
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Inserting Pictures
You can insert, resize and format pictures like a company logo just about 
anywhere in your survey. When you insert a picture, you either embed it 
in or link it to the survey. An embedded picture is stored with the survey. 
A linked picture has only its location stored with the survey.

Figure 8: An embedded picture in the Survey Designer window.

Inserting Survey Blocks
You can type and format titles, section headings, instructions and other 
text directly in the Survey Designer window. However, when you want to 
enter a question, you must use a survey block.

A survey block in the Survey Designer window is a special table that can 
contain one or more survey questions, or just text or pictures.

Ross Printers’ 
company 
logo.
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When the cursor is inside a block in the Survey Designer window, Survey 
Crafter Professional draws a border around the block.

Figure 2 - 9: A survey in the Survey Designer window.

Survey Block Layouts
Before you insert a block into the Survey Designer window, you must 
choose a layout for the block. You can choose a layout for your block 
from Survey Crafter Professional’s gallery of block layouts. Survey 
Crafter Professional displays the gallery on the Question Block Layouts 

Displays the 
block style for 
the currently 
selected 
block.

Survey 
blocks.

Formatted text 
not inside any 
block.

To insert a 
survey block, 
drag and drop 
a layout from 
the gallery on 
the Question 
Block Layouts 
toolbar into 
the Survey 
Designer 
window.
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toolbar as well as on the Type tab of the Question Block Wizard dialog 
box.
 

Figure 10: The Type tab of the Question Block Wizard dialog box.

A block layout represents a particular organization and presentation of the 
components of a survey block. A block layout dictates how the 
instructions, questions, prompts and other components of a block are 
arranged. For example, one block layout may display a closed-end 
question’s prompts in a single column below the question whereas 
another may display the prompts in a single row to the right of the 
question.

A block layout can also dictate the type and location of the block’s 
controls. For example, when the Survey Designer window is in Web 
Layout or Interviewer Layout mode, many of the block layouts designed 
for 1 closed-end question employ radio button controls while others 
employ single-selection list box controls.

Most block layouts are designed to work with one or more of just one type 
of question. However, there are several block layouts that are designed to 
work with more than one type of question. For example, there is a block 

Choose the type of 
block you want from 
the drop down.

Several block 
layouts 
designed for 1 
closed-end 
question 
employ single-
selection list 
box controls.

Each type of block has 
its own gallery of block 
layouts.

Double-click on a 
layout’s picture to see 
an example and read 
about the layout.

Many of the 
block layouts 
designed for 1 
closed-end 
question 
employ radio 
button 
controls.
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layout that combines multiple closed-end questions with one ranking 
question.

Figure 11: A block that combines multiple closed-end questions with one ranking question.

Survey Layout Modes
The Survey Designer window’s layout modes allow you to tailor your 
survey for printing, the World Wide Web and telephone interviewing. 
This means you can use Survey Crafter Professional to simultaneously 
administer paper, Web and telephone interview versions of your survey.

Survey Crafter Professional displays the current layout mode in the 
caption of the Survey Designer window. You can change the current 
layout mode by choosing a different layout mode from the View menu or 

Lists the 5 
imported 
category 
variables and 
5 imported 
quantity 
variables 
associated 
with the 
question 
block.

This question 
block contains 
5 closed-end 
questions and 
1 ranking 
question.

These block 
layouts 
combine 
question 
types.
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by clicking on one of the layout mode buttons on the Survey Question 
toolbar.

Figure 12: The Survey Designer window in Print Layout mode.

When the Survey Designer window is in one layout mode and you choose 
a block layout for a question block that is not compatible with another 
layout mode, Survey Crafter Professional automatically assigns a similar 
but compatible block layout for the question block when the Survey 
Designer window is switched to the other layout mode.

For example, if you choose a block layout that has respondents circle the 
prompts for a question block when the Survey Designer is in the Print 
Layout mode, Survey Crafter Professional automatically assigns a block 
layout that uses radio button or check box controls for the question block 
when the Survey Designer window is switched to the Web Layout and 
Interviewer Layout modes.

The caption 
indicates the 
Survey 
Designer 
window is in 
Print Layout 
mode.

The Survey 
Question 
toolbar 
indicates the 
Survey 
Designer 
window is in 
Print Layout 
mode.

The last 4 
block layouts 
are only for 
the Print 
Layout mode.
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Survey Crafter Professional displays the same survey text and graphics in 
all layout modes. If you change the survey text or graphics when the 
Survey Designer window is in one layout mode, the same change appears 
when the Survey Designer window is switched to the other layout modes. 
Survey Crafter Professional only allows a question block’s layout to be 
different between layout modes.

You can view the Survey Designer window at any time in Print Layout, 
Web Layout or Interviewer Layout mode.

Data Set

After creating your survey in Survey Crafter Professional, you can 
publish the survey on the World Wide Web, interview respondents 
yourself, have respondents complete the survey on their own, or contract 
a market research supplier to conduct interviews for you. 
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Before you can analyze a set of survey responses, you need to add the 
data to the Survey Crafter Professional study. If you are interviewing 
respondents yourself, you can add their responses using Survey Crafter 
Professional’s built-in Interviewer.

Figure 13: Survey Crafter Professional’s built-in Interviewer.

If you published your survey on the World Wide Web, you can import the 
web survey’s data into the study. If a market research supplier interviewed 
respondents, you can import the data the supplier returns into the study. 
Once the data is in the study, you can edit it to prepare it for analysis.

Enter the responses 
here.

Use these buttons to 
advance to the next 
respondent.

The caption of the 
window indicates 
which respondent 
you are working on 
as well as which 
page of the survey is 
being displayed.
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The Data Window
The study’s data set is comprised of values stored in variables. It includes 
variables with values you enter or import into the study (imported 
variables) and variables with values you calculate in Survey Crafter 
Professional (computed variables).

Figure 14: A data set in the Data window.

Each row in a data set is called a record. Each record contains data from a 
different respondent. Select an entire record by clicking on a row selector. 
Each column in a data set contains the values in one of the study’s 
variables. The variable’s name and code appears at the top of the column. 
Select an entire variable by clicking on a column selector. 

When the Data window is active, you can use commands on the Edit, 
View and Interviewer menus to modify the window’s display and edit 
variables’ values 

Row 
selectors

Column 
selectors

Each row is 
called a 
record. 
Each record 
contains 
data from a 
different 
respondent.

There are 
779 records 
in this data 
set.
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Records Appearing in the Data Window
You can display all or a portion of the data set’s records. For example, you 
could choose to view only those records for respondents who heard about 
your company on the radio.

Figure 15: A filtered data set in the Data window.

To filter the records appearing in the Data window, choose the Edit Filter 
command from the Edit menu. Then use the Expression Builder to write 
an expression that evaluates to TRUE or FALSE for each respondent in 
the data set. For example, gen_publicity=’radio’.

Records of respondents for whom the expression evaluates to TRUE 
appear in the Data window. The Data window’s Filter field shows the 
expression applied to the data set’s records. When no expression appears 
in this field, all records are displayed.

The filter 
expression 
is 
gen_publicit
y=’radio’

Only those 
respondents 
for whom the 
filter 
expression 
evaluates to 
TRUE 
appear in 
the Data 
window.
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Values Appearing in the Data Window
Each variable’s column may contain one of three types of values:  
categories, quantities, or literals (text). Category, quantity, and literal 
variables’ cells may also contain the value NV. NV (No Value) indicates 
that the record contains no value for the variable. For example, if the 
respondent was not asked a particular question, the question’s variable 
would contain NV. In addition, category and quantity variables’ cells may 
contain the value NR. NR (No Reply) indicates that the respondent was 
asked the question with which the variable is associated but refused to 
answer.

A computed variable’s values may all appear as NV. If this is the case, it is 
likely that Survey Crafter Professional has not yet calculated the 
variable’s values. To calculate the variable’s values, make the Data 
window the active window and then choose the Update command from 
the Edit menu.

Color Coding in the Data Window
Survey Crafter Professional uses color coding to indicate the status of 
values in the Data window. Imported variables’ values appear in black, 
blue and red. Computed variables’ values appear in gray.

Often, not all of the responses in a data set match values you expected. 
Some responses may lie outside an acceptable range, or they might not 
match the kind of information the question was designed to capture. For 
example, a question might require a ‘yes’ or ‘no’ answer but one record 
shows the value 35 for that question. Survey Crafter Professional features 
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a Data Error Log that flags erroneous values. You can edit these values or 
delete the record from the data set.

Figure 16: Using the Data Error Log to isolate unreadable values in the data set.

After editing data, you can have Survey Crafter Professional scan the data 
set again to check whether the values resulting from your changes meet 
the variables' specifications as well as pass your own custom data 
cleaning rules. To have Survey Crafter Professional scan the data set 
again, choose Update from the Edit menu.

You can add your own custom data cleaning rules to your study from 
either the Survey Designer window or the Data window.

Exporting from the Data Window
In addition to entering, importing, and editing data, you can export data 
for use in other software packages like SPSS or Microsoft Excel. You can 
export data from the Data window to a CSV (comma separated value) text 
file, to a Microsoft Excel® 97 workbook file or to an HTML file.

Clicking on 
the Show 
button 
automatically 
sets the Data 
window’s filter 
to isolate the 
unreadable 
value.

The Data Error 
Log window 
shows there’s 
1 unreadable 
value in the 
gen_company
size column.
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Analyses

Survey Crafter Professional supports numerous analyses of a study’s data 
set. You can perform basic analyses like finding how many respondents 
are likely to shop at a clothing store again and more advanced analyses 
like correlating respondents’ distance from a clothing store with the 
likelihood that they will shop at the clothing store again.

Survey Crafter Professional includes 10 wizards to create analyses 
common to survey research. For example, use a wizard to create a cross 
tabulation or a pie chart. You can also create custom analyses.

You can also show a table’s results in a chart and quickly switch between 
viewing the results as a table or chart. Figure 17 shows an analysis’ 
results in a table and its corresponding chart. 

Figure 17: A cross tabulation in the Analysis window (background) and the corresponding chart.
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Survey Crafter Professional provides a full range of formatting options 
for both tables and charts. Once you’ve created and formatted a table or 
chart, you can print it or copy and paste it into a report or presentation 
you’re working on in another program like Microsoft Word or Microsoft 
PowerPoint.

You can also design a batch report and have Survey Crafter Professional 
print and/or export a series of analysis tables and charts together as one 
report.

If you have access to a website and want others to see the results on the 
Web or your company’s intranet, Survey Crafter Professional makes it 
easy. With a few menu commands, you can generate an HTML version of 
your analysis tables or charts.

Variables

Each survey question has one or more variables associated with it to store 
respondents’ answers. For example, the variable likely_to_revisit might 
store responses to the question “How likely are you to shop at Rebecca’s 
Fashion Outlet again?” Variables that store survey responses are called 
imported variables. These variables are called imported because they 
store data coming from outside Survey Crafter Professional.

As you enter your survey into Survey Crafter Professional, Survey Crafter 
Professional automatically creates and maintains the imported variables 
associated with your survey’s questions. When Survey Crafter 
Professional creates an imported variable, it specifies the values that are 
acceptable for the variable to store. For example, acceptable values for the 
variable likely_to_revisit could be “Unlikely,” “Some chance,” “Fifty-
fifty chance,” “Likely,” and “Highly probable.” Acceptable values for the 
variable age in a survey of teenagers might be numbers from 13 to 19.

In addition to imported variables, Survey Crafter Professional supports 
computed variables. A computed variable is a variable that stores values 
Survey Crafter Professional calculates from values in imported variables 
or other computed variables. For example, if the imported variable 
income stores a respondent's income and spouse_income stores the 
respondent's spouse's income, you could create a computed variable 
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called family_income that stores the sum of the values in these two 
variables. Survey Crafter Professional includes wizards to help you create 
some of the most popular types of computed variables.

Study Limits

Survey Crafter Professional has been tested to the limits of 1000 survey 
blocks, 3000 variables, 16,000,000 records, and 100 analyses for a study. 
Survey Crafter Professional does not enforce these limits, but we 
recommend that you keep your studies within them.
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Touring Survey Crafter Professional Online

You can learn more about Survey Crafter Professional’s features and how 
to use them by viewing the Survey Crafter Professional Quick Preview. 
The Quick Preview introduces you to Survey Crafter Professional’s 
primary features by walking through an example study about a fast food 
restaurant.

You can view the Quick Preview from Survey Crafter Professional or 
from the Windows desktop. 

• To view the Quick Preview from Survey Crafter Professional

1 From the Help menu, choose Quick Preview.

2 Follow the directions on the screen to navigate the Quick Preview.

• To view the Quick Preview from the Windows desktop

1 Click on the Start button and then on All programs. Scroll the list of 
programs until you see a folder called Survey Crafter Professional 
5.1, click on it and then on Quick Preview - Survey Crafter 
Professional.  Alternatively, double click on the Survey Crafter 
Professional Quick Preview icon on the Windows desktop.

2 Follow the directions on the screen to navigate the Quick Preview.

Tip You can also access the Quick Preview when starting Survey 
Crafter Professional. At the Welcome screen, click on Take a guided 
tour.

Survey Crafter 
Professional Quick 
Preview icon
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Sample Study and Surveys

For exploring Survey Crafter Professional on your own, the application 
includes a sample study and seven sample surveys.

Sample Study

The sample study tells the story of how Ross Printers, a small printing 
business, used Survey Crafter Professional to answer key questions about 
their customers, advertising, and performance.

To open the sample study in Survey Crafter Professional, click on the 
Windows Start button and then on All programs. Scroll the list of 
programs until you see a folder called Survey Crafter Professional 5.1, 
click on it and then on Survey Crafter Professional 5.1. From Survey 
Crafter Professional’s Welcome screen, click on Browse the sample 
studies folder. Then click on Casestdy.mkt and then on Open.

Read the Microsoft Word document CASESTDY.DOC to follow Ross 
Printers step-by-step as they use Survey Crafter Professional to help make 
decisions. To read the document, from Survey Crafter Professional, click 
on the program’s File menu and then on Browse Samples. Click on the 
Files of type drop down and choose All files (*.*). Then right-click on the 
file Casestdy.doc and choose Open from the pop-up menu. The document 
draws on information from these supporting files:

• CASESTDY.MKT, the Survey Crafter Professional study Ross Printers 
created while answering their questions

• CASESTDY.DAT, the data file containing the survey responses

• CASESTDY.DCT, the data dictionary file Ross Printers used to import 
the data in CASESTDY.DAT into Survey Crafter Professional in order 
to analyze it

Sample Surveys

The sample surveys illustrate a number of scenarios. To open a sample 
survey study file, click on the Windows Start button and then on All 
programs. Scroll the list of programs until you see a folder called Survey 
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Crafter Professional 5.1, click on it and then on Survey Crafter 
Professional 5.1. From Survey Crafter Professional’s Welcome screen, 
click on Browse the sample studies folder. Then click on the sample 
survey you want and then on Open. Scenarios include:

• A bed & breakfast inn collecting feedback on customer profiles and the 
effectiveness of its advertising (B&B.MKT)

• A bank looking for suggestions on how to improve its customer 
satisfaction (BANK.MKT)

• A mid-sized software company measuring employee satisfaction 
(EMPLOY.MKT)

• A clothing retailer gathering information about customer demographics 
and the effectiveness of its marketing campaign (FASHION.MKT) 

• A grocery store learning about who its customers are and how often 
they shop at competitors’ stores (GROCERY.MKT)

• A newspaper measuring voters’ opinions about an upcoming election 
(POLITICS.MKT)

• A restaurant looking for suggestions on how to improve its customer 
satisfaction (RESTARNT.MKT)

• A fast food restaurant looking to learn more about fast food restaurant 
customers in order to expand its customer base (FOOD.MKT).
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